Software FAQ Lists for
4D QuiltDesign Creator

4D QBOT Configure

Listed versions: 1.1

Qco01 Message "An unidentified program wants access to your computer."”

This message may appear in Windows® Vista, when installing 4D QBOT Software. The message is provided by
the User Account Control system in Windows® Vista. Click the Allow option to continue.

Qco02 Message "A program needs your permission to continue."

This message may appear in Windows® Vista, when installing 4D QBOT Software. The message is provided by
the User Account Control system in Windows® Vista. Click Continue to proceed with installation.

Qcoo3 When | start 4D QBOT Configure, | cannot see the OK, Cancel, Apply
and Help buttons at the bottom of the window

Your 4D QBOT Software requires a minimum screen resolution of 1024 by 768 pixels. If your screen resolution is
less than this (800 by 600 or less) and you have changed the screen DPI value in Advanced display settings, you
may not be able to see all of the screen elements in 4D QBOT Configure. A reduced screen resolution will also
affect other parts of the 4D QBOT Software.

Reset the display as follows.

1. Right-click on the desktop and a shortcut menu appears.

2. In Windows® Vista, click Personalize, then click Display Settings in the window that appears.
3. In Windows® XP, click on Properties and a dialog box appears. Click the Settings tab.

4. In both cases, Move the Screen resolution slider to at least 1024 by 768 pixels.

5. Click OK, and allow your computer to restart if required.

Qcoo4 How do | change my personal information for my software registration?

Simply click the Register button in 4D QBOT Configure and repeat the registration process. This does not change
the registration status of software you have already registered, but it does allow you to change your personal
information and/or dealer information. You can also obtain your free designs if you have not already done so.

Ensure your dongle is connected to your computer before you start, so that your current registration details can
be easily retrieved.

If your dongle is not connected, you will need to enter your surname, e-mail address and Zip/post code to find
your registration details.

QG001 Message "Error 7. Dongle not found. Please attach the correct dongle to
a USB port of your computer.”



This message will appear when trying to start a module if the 4D QBOT Software cannot detect the dongle (data
protection device). Ensure the dongle is plugged into a free USB port of your computer.

QG002 Message "Error 14. Dongle driver not found."

This message will appear if the dongle driver is not accessible, has been removed or has not been installed
correctly.

First, ensure you are logged onto your computer with full administrator rights and attempt to use the desired 4D
QBOT Software module. If the error message no longer appears, then the user name you originally tried to use is
too restricted to use the 4D QBOT Software.

Otherwise, use the dongle driver installation utility in the \Technical\Dongle Driver folder of your 4D QBOT
Software CD. Ensure you are logged onto your computer with full administrator rights before using the dongle
driver installation utility.

QG003 General difficulties with hardware and software

To try to determine the cause of any odd difficulties with the 4D QBOT Software, the best method is to reboot the
computer in safe mode. If the problem is then solved, you know that some clash of hardware and/or software
such as device drivers is to blame. You can then obtain more help from your computer dealer to analyze the
cause and reconfigure your computer if necessary.

To start Windows in Safe Mode

1. Close all programs.

2. Use the shortcut Alt + F4 (hold down the Alt key, then press F4 once) and the Shut Down Windows dialog
box will appear.

3. In the drop-down list, select Restart. Click OK to confirm.

4. Your computer will shut down and restart.

5. As your computer restarts, press and hold the F8 key until a menu of windows startup options appears.

6. Use the up and down arrow keys to highlight Safe mode, and then press ENTER.

When you hold down the F8 key, your computer may beep rapidly and report keyboard errors as it restarts.
Release the F8 key briefly to skip any errors and press F8 again until you have the Startup Menu on your screen.

QG004 Message "Some changes will take effect only when modules are
restarted."”
Some changes to settings on the System tab of 4D QBOT Configure are only seen in the 4D QBOT Software

modules when the modules are closed and restarted. If you have made changes that do not appear immediately,
save your design(s), close the 4D QBOT Software modules, then start them again.

4D QBOT Designer

Listed versions: 1.1

Qpoo1 Error message "Could not load picture file."

This message could appear if the desired picture is not where the module expects it to be, for example if it was
loaded from a floppy disk, then closed and the floppy disk removed. The message would appear if you try to load
the picture from the Recent Files list on the File menu. It could also appear if the file you are attempting to load is
corrupt. For example, it might have an extension such as .bmp or .jpg, yet not be a proper picture file.



QD002 Error "QuickTrace Design could not be completed as the design is too
large."

This message could appear if the design that you are attempting to trace is too large. For example, the design
area may be greater than approximately 31"x31" or the area taken up by the objects may be greater than
approximately 22"x22". Reduce the size of the design using Design Area or Select All and resizing the selection
box. Then attempt to trace it again.

Alternatively, the design may be an embroidery design with areas of 'solid’ stitching, so that QuickTrace Design
cannot find a path through.

QD003 | am unable to cut the desired section of the design using the Knife

The knife tool separates areas to the left and right of the cut line. If the cut line is complex, for example if it goes
into an area and then back out of it, or is a spiral, it may lead to some sections appearing on an unexpected side
of the cut line. Try cutting the design in more than one stage using simpler Knife lines.

QDoo4 Message "Problem with scanner or camera software."

This message will appear when trying to use your scanner or digital camera if the device has not been installed
correctly. Close 4D QBOT Designer, follow the manufacturer's instructions for the Twain-compliant device, then
reopen 4D QBOT Designer and try again.

QD005 Message "Scanner or camera is in use by another application."”

This message will appear when trying to use your scanner or digital camera if another graphics program is
already open that uses the Twain-compliant device. Close 4D QBOT Designer and the other graphics program,
then reopen 4D QBOT Designer and try again.

QD006 Message "Your scanner is no longer available for use. Close this
program, plug in and switch on your scanner, and run this program again."

This error appears if the connection to your scanner or digital camera has a problem. Close 4D QBOT Designer,
check the connections to your scanner or digital camera, then reopen the program and try again.

QD007 Message "Failure to acquire picture due to unknown causes."

This message will appear in certain circumstances when trying to use your scanner or digital camera, for example
if the cable is disconnected during the scan or download. Close 4D QBOT Designer, check the connections to
your scanner or digital camera, then reopen 4D QBOT Designer and try again.

Qpoo8 Error message "Corrupt or Incorrect design file."

This message appears if a design file cannot be loaded. For example, it might have the extension .4gb, yet not be
a proper design outline file.

QD009 Message "This file cannot be opened.”

This message appears if a file is 'locked'. For example, you may try to open an AutoCAD DXF (.dxf) file that is
also being worked on in another program (for example, if you have saved it and it is still open in that program).

QDo10 Message "You cancelled during loading."



This message appears when cancelling the dialog box that appears for setting the size during the opening of an
AutoCAD DXF (.dxf) file.

QDo11 Message "Error. This file cannot be opened because there were no
objects in the file that are supported in this software."

This message may appear when opening non-.4qgb files. For example it could be an .wmf or .emf file with just a
raster picture with no outlining inside it (such as a bitmap), or it could be a .dxf file with no objects supported. The
following elements of the AutoCAD (.dxf) format are imported: line, polyline (most types including LW-Polyline),
arc, circle and ellipse.

Qpo12 Message "Some of the features contained inside this file are not
supported in this software."

This message may appear when opening non-.4qgb files. For example it could be an .wmf or .emf file with a raster
picture and some outlines, or it could be a .dxf file with some objects supported. The following elements of the
AutoCAD (.dxf) format are imported: line, polyline (most types including LW-Polyline), arc, circle and ellipse.

QD013 Message "No design sections could be created. Picture has been loaded
as a background image."

This message may appear when using QuickTrace Picture if the picture has thick areas of solid color. Some or all
parts of the design may not be created. Try using options in the wizard, on the Outline Finder and Expander page
and/or the Monochrome Threshold page, to ensure the outlines are not too thick.

Qpo14 When | imported an AutoCAD DXF (.dxf) file, my blocks were not
imported as groups
The following elements of the AutoCAD format are imported: line, polyline (most types including LW-Polyline), arc,

circle and ellipse. An object that is within an AutoCAD block will be imported, but the block data will not be kept as
a group. Use Object Select (or another of the selection tools) and Group the AutoCAD block if desired.

Qpo15 Error "Design File is read-only. Cannot continue."

This will happen if you attempt to open a design that has been set as read-only, or is read-only because it is
stored on a CD-ROM. If the design file is on your hard disk as read-only then you must change its properties in
Windows® Explorer so that it is no longer read-only. For designs on CD-ROMs, use Windows® Explorer to copy
them to your hard disk, then change the properties so that they are no longer read-only. (Windows® Explorer
Help has information on the read-only attribute.)

QDpo16 Message "Filename already exists. Do you want to replace it?"

This happens when you are doing a Save As on the .4gb quilting design file and you have given the name of a file
that is already there.

QD017 Message "Elements cannot be placed outside the boundaries of the Work
Area."
This happens when you are doing a Save As on a work area, and part of the design lies outside the edge of the

work area. Move these objects within the boundaries of the work area, or Select All and reduce the size of the
design, then save again.



QD018 Message "Could not save the picture."

This message may appear on attempting to save the picture, for example, if you attempt to overwrite an existing
picture that is read-only or if you attempt to save the picture to a read-only location such as a CD-ROM.

QD019 Message "Disk is write-protected. File not saved”

This will happen if you try to save a file to a floppy disk that has the write-protect tab open. Either take out the
floppy disk and close the write-protect tab, or use a different floppy disk.

QD020 Message "No objects available to print."

This message appears if the design has no objects to print. To be printed, a design must have at least one object.

QD021 | have moved the Drawing panel, and | can't put it back in position

If the control panel is 'floating' on top of the window, double-click the title bar and the control panel will move back
to its original position.

If the control panel is docked on the wrong side of the window, click and drag the title bar to the middle of the
right-hand edge of the window until the outline snaps into position on the right. Release the mouse button and the
control panel will be dropped into its original position.

Using Reset All Modules in 4D QBOT Configure will also return the control panel to its original position.

QD022 Some of the icons in the Toolbar are 'grayed out'

Certain icons (for example Send To QBOT on the Main toolbar) are only highlighted once a design is shown on
the screen.

QD023 | have changed grid color and spacing and now | wish to return to the
original settings

Use 4D QBOT Configure to change the grid color. Follow the instructions in 4D QBOT Configure and select Blue
Gray (RGB values 102, 102, 153) from the standard color dropdown on the Grid Color button.

Use Screen Preferences to change the grid spacing. Set the Grid Size to 0.5".

QD024 | wish to change the background color for the work area

Use 4D QBOT Configure to alter the background color for the work area.

QD025 | can't remove part of a group

A group is selected as a single unit. You cannot select a part of a group in the design area. To remove part of a
group, either use Ungroup and remove the chosen piece, or select the piece from the FilmStrip. If you used
Ungroup you can use Group to make a group of the remaining pieces.

QD026 | can't see the control panel
Close 4D QBOT Designer, and then start it again. The control panel should appear.

QD027 | cannot append or close lines when using Multiply



Lines cannot be appended or closed when using Multiply. If you need to append or close a line, do this before you
enable Multiply.

QD028 QuickTrace Design did not make a background image

QuickTrace Design will not make a background image if the design area is too large (greater than approximately
31" square). However, the design will still be traced and placed in a new element tabbed page if the objects in the
design are less than approximately 22" square. If you need the background image, reduce the Design Area before
you trace it.

QG001 Message "Error 7. Dongle not found. Please attach the correct dongle to
a USB port of your computer.”

This message will appear when trying to start a module if the 4D QBOT Software cannot detect the dongle (data
protection device). Ensure the dongle is plugged into a free USB port of your computer.

QG002 Message "Error 14. Dongle driver not found."

This message will appear if the dongle driver is not accessible, has been removed or has not been installed
correctly.

First, ensure you are logged onto your computer with full administrator rights and attempt to use the desired 4D
QBOT Software module. If the error message no longer appears, then the user name you originally tried to use is
too restricted to use the 4D QBOT Software.

Otherwise, use the dongle driver installation utility in the \Technical\Dongle Driver folder of your 4D QBOT
Software CD. Ensure you are logged onto your computer with full administrator rights before using the dongle
driver installation utility.

QG003 General difficulties with hardware and software

To try to determine the cause of any odd difficulties with the 4D QBOT Software, the best method is to reboot the
computer in safe mode. If the problem is then solved, you know that some clash of hardware and/or software
such as device drivers is to blame. You can then obtain more help from your computer dealer to analyze the
cause and reconfigure your computer if necessary.

To start Windows in Safe Mode

1. Close all programs.

2. Use the shortcut Alt + F4 (hold down the Alt key, then press F4 once) and the Shut Down Windows dialog
box will appear.

. In the drop-down list, select Restart. Click OK to confirm.

. Your computer will shut down and restart.

. As your computer restarts, press and hold the F8 key until a menu of windows startup options appears.

. Use the up and down arrow keys to highlight Safe mode, and then press ENTER.
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When you hold down the F8 key, your computer may beep rapidly and report keyboard errors as it restarts.
Release the F8 key briefly to skip any errors and press F8 again until you have the Startup Menu on your screen.

QG004 Message "Some changes will take effect only when modules are
restarted.”
Some changes to settings on the System tab of 4D QBOT Configure are only seen in the 4D QBOT Software

modules when the modules are closed and restarted. If you have made changes that do not appear immediately,
save your design(s), close the 4D QBOT Software modules, then start them again.



QG005 | have changed the screen background color and now | wish to return to
the original light blue

Use 4D QBOT Configure to change the background color. Follow the instructions in 4D QBOT Configure and
select the RGB values 200, 232, 247 in the Colors dialog box.

QG006 | can't see some of the floating toolbars or icons

Use Reset All Modules in 4D QBOT Configure to return all toolbars in the module to their default settings.
To use Reset All Modules

. Ensure your designs are saved in any 4D QBOT Software modules that are open.

. Click 4D QBOT Configure on the QuickLink toolbar.

. Click Reset All Modules.

. A message will appear, indicating that all modules will be closed and reset. Click OK.

. A message will appear, asking you to ensure that all other 4D QBOT Software modules have closed, apart
from 4D QBOT Configure. Click OK.

. A message will appear, indicating that all modules have now been reset. Click OK. The toolbars in your
module will have been restored.
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If preferred, you can check individual toolbars in View, Customize. Use this to see if the missing toolbar has been
turned off, and also to reset the toolbar if icons have been added to or removed from the toolbar. If this does not
restore the toolbar, use Reset All Modules.

QG007 The toolbar icons have unexpectedly changed to a smaller size

Use Reset All Modules in 4D QBOT Configure to return all toolbars in the module to their default settings QG006.

Alternatively, to change the icon size in this module only, select View, Customize, then go to the Options tab and
select the Large Icons option.

QG008 Message "Cannot save file."

The program cannot save the file. Ensure that the disk where you are trying to save the design is not write-
protected, then try again.

QG009 Error "Not enough memory to perform operation."

This message will appear if system resources are low. Close other programs and try again. If this does not work,
try restarting your computer.

4D QBOT Vision

Listed versions: 1.1

QG001 Message "Error 7. Dongle not found. Please attach the correct dongle to
a USB port of your computer.”

This message will appear when trying to start a module if the 4D QBOT Software cannot detect the dongle (data
protection device). Ensure the dongle is plugged into a free USB port of your computer.

QG002 Message "Error 14. Dongle driver not found."



This message will appear if the dongle driver is not accessible, has been removed or has not been installed
correctly.

First, ensure you are logged onto your computer with full administrator rights and attempt to use the desired 4D
QBOT Software module. If the error message no longer appears, then the user name you originally tried to use is
too restricted to use the 4D QBOT Software.

Otherwise, use the dongle driver installation utility in the \Technical\Dongle Driver folder of your 4D QBOT
Software CD. Ensure you are logged onto your computer with full administrator rights before using the dongle
driver installation utility.

QG003 General difficulties with hardware and software

To try to determine the cause of any odd difficulties with the 4D QBOT Software, the best method is to reboot the
computer in safe mode. If the problem is then solved, you know that some clash of hardware and/or software
such as device drivers is to blame. You can then obtain more help from your computer dealer to analyze the
cause and reconfigure your computer if necessary.

To start Windows in Safe Mode

1. Close all programs.

2. Use the shortcut Alt + F4 (hold down the Alt key, then press F4 once) and the Shut Down Windows dialog
box will appear.

3. In the drop-down list, select Restart. Click OK to confirm.

4. Your computer will shut down and restart.

5. As your computer restarts, press and hold the F8 key until a menu of windows startup options appears.

6. Use the up and down arrow keys to highlight Safe mode, and then press ENTER.

When you hold down the F8 key, your computer may beep rapidly and report keyboard errors as it restarts.
Release the F8 key briefly to skip any errors and press F8 again until you have the Startup Menu on your screen.

QG004 Message "Some changes will take effect only when modules are
restarted.”

Some changes to settings on the System tab of 4D QBOT Configure are only seen in the 4D QBOT Software
modules when the modules are closed and restarted. If you have made changes that do not appear immediately,
save your design(s), close the 4D QBOT Software modules, then start them again.

QG005 | have changed the screen background color and now | wish to return to
the original light blue

Use 4D QBOT Configure to change the background color. Follow the instructions in 4D QBOT Configure and
select the RGB values 200, 232, 247 in the Colors dialog box.

QG006 | can't see some of the floating toolbars or icons

Use Reset All Modules in 4D QBOT Configure to return all toolbars in the module to their default settings.
To use Reset All Modules

. Ensure your designs are saved in any 4D QBOT Software modules that are open.

. Click 4D QBOT Configure on the QuickLink toolbar.

. Click Reset All Modules.

. A message will appear, indicating that all modules will be closed and reset. Click OK.

. A message will appear, asking you to ensure that all other 4D QBOT Software modules have closed, apart
from 4D QBOT Configure. Click OK.

. A message will appear, indicating that all modules have now been reset. Click OK. The toolbars in your
module will have been restored.
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If preferred, you can check individual toolbars in View, Customize. Use this to see if the missing toolbar has been
turned off, and also to reset the toolbar if icons have been added to or removed from the toolbar. If this does not



restore the toolbar, use Reset All Modules.

QG007 The toolbar icons have unexpectedly changed to a smaller size

Use Reset All Modules in 4D QBOT Configure to return all toolbars in the module to their default settings QGO006.

Alternatively, to change the icon size in this module only, select View, Customize, then go to the Options tab and
select the Large Icons option.

QG008 Message "Cannot save file."

The program cannot save the file. Ensure that the disk where you are trying to save the design is not write-
protected, then try again.

QG009 Error "Not enough memory to perform operation."

This message will appear if system resources are low. Close other programs and try again. If this does not work,
try restarting your computer.

Qvoo1 Message "Problem with scanner or camera software."

This message will appear when trying to use your scanner or digital camera if the device has not been installed
correctly. Close 4D QBOT Vision, follow the manufacturer's instructions for the Twain-compliant device, then
reopen 4D QBOT Vision and try again.

Qvoo2 Message "Scanner or camera is in use by another application."

This message will appear when trying to use your scanner or digital camera if another graphics program is
already open that uses the Twain-compliant device. Close 4D QBOT Vision and the other graphics program, then
reopen 4D QBOT Vision and try again.

Qvoo3 Message "Your scanner is no longer available for use. Close this
program, plug in and switch on your scanner, and run this program again."

This error appears if the connection to your scanner or digital camera has a problem. Close 4D QBOT Vision,
check the connections to your scanner or digital camera, then reopen the program and try again.

Qvoo4 Message "Failure to acquire picture due to unknown causes."

This message will appear in certain circumstances when trying to use your scanner or digital camera, for example
if the cable is disconnected during the scan or download. Close 4D QBOT Vision, check the connections to your
scanner or digital camera, then reopen 4D QBOT Vision and try again.

Qvoo5 Message "Error. The quilt background could not be saved."

This message could appear when saving a quilt in the Quilt Background Wizard if the location for saving to is no
longer available (for example, a folder has been moved).

Qvooe Message "Error. The quilt background xxxx could not be found."

This appears if the background quilt is not found. This can happen if the name has been changed, or the location
is no longer available (for example, a folder has been moved).



Qvoo7 Message "Error. The quilt background is corrupt or incorrect."

This appears if the background quilt is not found. This can happen if the name has been changed, or the location
is no longer available (for example, a memory stick has been removed).

Qvoos Message "Error. Some designs could not be found."

This appears if one or more quilting or embroidery designs are not found. This can happen if the name has been
changed, or the location is no longer available (for example, a memory stick has been removed). A list of designs
that could not be found is given.

Qvoo9 Message "Failed loading design file xxxx. This design is ignored."

This appears if the embroidery or quilting design is corrupt in some way, for example if the file extension is .4qgb,
but it is not a true .4qgb file.

Qvo10 Message "The design will be scaled down to fit."

This message appears if the .4gb design file is too large in at least one dimension. The design will be
automatically scaled to fit.

Qvo11 Message "Error. This file cannot be opened because it is not the correct
file format."

This message appears if you try to open a file that is of the wrong type, or is corrupt.

Qvo12 Message "Error. This file cannot be opened."

This message appears if you try to open a file that is of the wrong type, or is corrupt.

Qvo13 Error "Cannot open embroidery."

This message appears if the desired embroidery is not where the module expects it to be, for example if an
embroidery was loaded into the module from a floppy disk, then closed and the floppy disk removed. The
message would appear if you tried to load the embroidery from the Recent Files list on the File menu.

Qvo14 Error "Unrecognized file format."

This message appears if the file you are attempting to load is corrupt. For example, it might have the extension
.vp3, yet not be a proper Husqvarna Viking / Pfaff embroidery.

Qvo15 Error: "Embroidery is corrupt”

The embroidery is corrupt and cannot be loaded. Refer to source of this file for a solution.

Qvo16 Error "Embroidery XY coordinates incorrect”

The embroidery is corrupt and cannot be loaded. Refer to source of this file for a solution.

Qvo17 Error "Unrecognized file extension."



This message appears if you attempt to load a file with an extension that does not belong to any embroidery file
types. For example, it would appear if you tried to Drag and Drop a .doc file onto the screen.

Qvo18 Error "Design not created using licensed software."

This message may appear if you attempt to load an embroidery created in third-party software. Such
embroideries may cause unpredictable results.

Qvo19 Error "Unrecognized file extension."

This message appears if you type an incorrect extension in the File Name box when trying to save a file.

QVv020 Error "Cannot save file."

This message appears if, for instance, you have loaded a file from a CD-ROM and then attempt to save the file
back to the CD. A CD-ROM is read only, therefore you will not be able to save the file.

Qvo21 Some of the icons in the Toolbar are 'grayed out

Certain icons (for example the Design and Edit toolbar icons) are only highlighted once a design is shown on the
screen. Additionally, when Realistic Mode is selected, all functions that will edit designs are unavailable.

Qvo22 | wish to change the background color for the work area

Use 4D QBOT Configure to alter the background color for the work area. 4D QBOT Configure may usually be
used to turn the texture on or off, but this is not available for 4D QBOT Vision.

Qvo23 My scanner or digital camera is not shown when | try to Select Source, or
the Select Source button is grayed out

The manufacturer of a TWAIN device must provide a Source Manager and a TWAIN Data source for your device
to work with 4D QBOT Vision. These will normally be installed when you install the software and drivers provided
with the device. If you have installed a device and it is not shown in the list then it may not be TWAIN compliant.
Refer to the device documentation and manufacturer for assistance.

Qvo24 | created a quilt from a fabric, but now | can't load it in the Quilt
Background Wizard option to load a previously saved quilt
Fabric backgrounds are not saved as separate quilts, but as part of the quilt layout file. Save the layout

immediately after sizing the fabric background if you wish to keep a copy of the whole-cloth quilt with no designs
placed on it.

4D QuiltDesign Configure

Listed versions: 2.0, 2.1

Qcoo5 Message "An unidentified program wants access to your computer.”

This message may appear in Windows® Vista, when installing 4D QuiltDesign Creator software. The message is
provided by the User Account Control system in Windows® Vista. Click the Allow option to continue.



Qcoo6 Message "A program needs your permission to continue."

This message may appear in Windows® Vista, when installing 4D QuiltDesign Creator software. The message is
provided by the User Account Control system in Windows® Vista. Click Continue to proceed with installation.

Qcoo7 When | start 4D QuitDesign Configure, | cannot see the OK, Cancel,
Apply and Help buttons at the bottom of the window

Your 4D QuitDesign Creator software requires a minimum screen resolution of 1024 by 768 pixels. If your screen
resolution is less than this (800 by 600 or less) and you have changed the screen DPI value in Advanced display
settings, you may not be able to see all of the screen elements in 4D QuitDesign Configure. A reduced screen
resolution will also affect other parts of the 4D QuitDesign Creator software.

Reset the display as follows.

1. Right-click on the desktop and a shortcut menu appears.

2. In Windows® Vista, click Personalize, then click Display Settings in the window that appears.
3. In Windows® XP, click on Properties and a dialog box appears. Click the Settings tab.

4. In both cases, Move the Screen resolution slider to at least 1024 by 768 pixels.

5. Click OK, and allow your computer to restart if required.

Qcoo8 How do | change my personal information for my software registration?

Simply click the Register button in 4D QuitDesign Configure and repeat the registration process. This does not
change the registration status of software you have already registered, but it does allow you to change your
personal information and/or dealer information. You can also obtain your free designs if you have not already
done so.

Ensure your dongle is connected to your computer before you start, so that your current registration details can
be easily retrieved.

If your dongle is not connected, you will need to enter your surname, e-mail address and Zip/post code to find
your registration details.

Qco09 Message: "Error 31. You must activate your dongle to continue using this
module. Go to 4D QuiltDesign Configure and select Activate Dongle."

When you have installed and registered 4D™ QuiltDesign Creator, you must activate the dongle. If you attempt to
run the modules before activating the dongle, this message will appear.

QG010 Message "Error 7. Dongle not found. Please attach the correct dongle to
a USB port of your computer.”

This message will appear when trying to start a module if the 4D QuiltDesign Creator software cannot detect the
dongle (data protection device). Ensure the dongle is plugged into a free USB port of your computer.

QG011 Message "Error 14. Dongle driver not found."

This message will appear if the dongle driver is not accessible, has been removed or has not been installed
correctly.

First, ensure you are logged onto your computer with full administrator rights and attempt to use the desired 4D
QuiltDesign Creator module. If the error message no longer appears, then the user name you originally tried to
use is too restricted to use the 4D QuiltDesign Creator software.

Otherwise, use the dongle driver installation utility in the \Technical\Dongle Driver folder of your 4D QuiltDesign
Creator CD. Ensure you are logged onto your computer with full administrator rights before using the dongle
driver installation utility.



QG012 General difficulties with hardware and software

To try to determine the cause of any odd difficulties with the 4D QuiltDesign Creator software, the best method is
to reboot the computer in safe mode. If the problem is then solved, you know that some clash of hardware and/or
software such as device drivers is to blame. You can then obtain more help from your computer dealer to analyze
the cause and reconfigure your computer if necessary.

To start Windows in Safe Mode

1. Close all programs.

2. Use the shortcut Alt + F4 (hold down the Alt key, then press F4 once) and the Shut Down Windows dialog
box will appear.

3. In the drop-down list, select Restart. Click OK to confirm.

4. Your computer will shut down and restart.

5. As your computer restarts, press and hold the F8 key until a menu of windows startup options appears.

6. Use the up and down arrow keys to highlight Safe mode, and then press ENTER.

When you hold down the F8 key, your computer may beep rapidly and report keyboard errors as it restarts.
Release the F8 key briefly to skip any errors and press F8 again until you have the Startup Menu on your screen.

QG013 Message "Some changes will take effect only when modules are
restarted.”
Some changes to settings on the System tab of 4D QuiltDesign Configure are only seen in the 4D QuiltDesign

Creator modules when the modules are closed and restarted. If you have made changes that do not appear
immediately, save your design(s), close the 4D QuiltDesign Creator modules, then start them again.

4D QuiltDesign Creator

Listed versions: 2.0, 2.1

QDoo1 Error message "Could not load picture file."

This message could appear if the desired picture is not where the module expects it to be, for example if it was
loaded from a floppy disk, then closed and the floppy disk removed. The message would appear if you try to load
the picture from the Recent Files list on the File menu. It could also appear if the file you are attempting to load is
corrupt. For example, it might have an extension such as .bmp or .jpg, yet not be a proper picture file.

QDoo2 Error "QuickTrace Design could not be completed as the design is too
large."

This message could appear if the design that you are attempting to trace is too large. For example, the design
area may be greater than approximately 31"x31" or the area taken up by the objects may be greater than
approximately 22"x22". Reduce the size of the design using Design Area or Select All and resizing the selection
box. Then attempt to trace it again.

Alternatively, the design may be an embroidery design with areas of 'solid’ stitching, so that QuickTrace Design
cannot find a path through.

QD003 | am unable to cut the desired section of the design using the Knife

The knife tool separates areas to the left and right of the cut line. If the cut line is complex, for example if it goes
into an area and then back out of it, or is a spiral, it may lead to some sections appearing on an unexpected side
of the cut line. Try cutting the design in more than one stage using simpler Knife lines.



QD008 Error message "Corrupt or Incorrect design file."

This message appears if a design file cannot be loaded. For example, it might have the extension .4gb, yet not be
a proper design outline file.

Qpoo9 Message "This file cannot be opened.”

This message appears if a file is 'locked'. For example, you may try to open an AutoCAD DXF (.dxf) file that is
also being worked on in another program (for example, if you have saved it and it is still open in that program).

Qpo10 Message "You cancelled during loading."

This message appears when cancelling the dialog box that appears for setting the size during the opening of an
AutoCAD DXF (.dxf) file.

QDo11 Message "Error. This file cannot be opened because there were no
objects in the file that are supported in this software."

This message may appear when opening non-.4qgb files. For example it could be an .wmf or .emf file with just a
raster picture with no outlining inside it (such as a bitmap), or it could be a .dxf file with no objects supported. The

following elements of the AutoCAD (.dxf) format are imported: line, polyline (most types including LW-Polyline),
arc, circle and ellipse.

QD012 Message "Some of the features contained inside this file are not
supported in this software."
This message may appear when opening non-.4qb files. For example it could be an .wmf or .emf file with a raster

picture and some outlines, or it could be a .dxf file with some objects supported. The following elements of the
AutoCAD (.dxf) format are imported: line, polyline (most types including LW-Polyline), arc, circle and ellipse.

QD013 Message "No design sections could be created. Picture has been loaded
as a background image."

This message may appear when using QuickTrace Picture if the picture has thick areas of solid color. Some or all
parts of the design may not be created. Try using options in the wizard, on the Outline Finder and Expander page
and/or the Monochrome Threshold page, to ensure the outlines are not too thick.

Qpo14 When | imported an AutoCAD DXF (.dxf) file, my blocks were not
imported as groups

The following elements of the AutoCAD format are imported: line, polyline (most types including LW-Polyline), arc,
circle and ellipse. An object that is within an AutoCAD block will be imported, but the block data will not be kept as
a group. Use Object Select (or another of the selection tools) and Group the AutoCAD block if desired.

Qpo15 Error "Design File is read-only. Cannot continue."

This will happen if you attempt to open a design that has been set as read-only, or is read-only because it is
stored on a CD-ROM. If the design file is on your hard disk as read-only then you must change its properties in
Windows® Explorer so that it is no longer read-only. For designs on CD-ROMs, use Windows® Explorer to copy
them to your hard disk, then change the properties so that they are no longer read-only. (Windows® Explorer
Help has information on the read-only attribute.)



QDo16 Message "Filename already exists. Do you want to replace it?"

This happens when you are doing a Save As on the .4qb quilting design file and you have given the name of a file
that is already there.

QD017 Message "Elements cannot be placed outside the boundaries of the Work
Area."

This happens when you are doing a Save As on a work area, and part of the design lies outside the edge of the
work area. Move these objects within the boundaries of the work area, or Select All and reduce the size of the
design, then save again.

Qpo18 Message "Could not save the picture."

This message may appear on attempting to save the picture, for example, if you attempt to overwrite an existing
picture that is read-only or if you attempt to save the picture to a read-only location such as a CD-ROM.

QD019 Message "Disk is write-protected. File not saved"

This will happen if you try to save a file to a floppy disk that has the write-protect tab open. Either take out the
floppy disk and close the write-protect tab, or use a different floppy disk.

QD020 Message "No objects available to print."

This message appears if the design has no objects to print. To be printed, a design must have at least one object.

QD025 | can't remove part of a group

A group is selected as a single unit. You cannot select a part of a group in the design area. To remove part of a
group, either use Ungroup and remove the chosen piece, or select the piece from the FilmStrip. If you used
Ungroup you can use Group to make a group of the remaining pieces.

QD027 | cannot append or close lines when using Multiply

Lines cannot be appended or closed when using Multiply. If you need to append or close a line, do this before you
enable Multiply.

QD028 QuickTrace Design did not make a background image

QuickTrace Design will not make a background image if the design area is too large (greater than approximately
31" square). However, the design will still be traced and placed in a new element tabbed page if the objects in the
design are less than approximately 22" square. If you need the background image, reduce the Design Area before
you trace it.

QD030 Message "Problem with scanner or camera software."

This message will appear when trying to use your scanner or digital camera if the device has not been installed
correctly. Close 4D QuiltDesign Creator, follow the manufacturer's instructions for the Twain-compliant device,
then reopen 4D QuiltDesign Creator and try again.

QD031 Message "Scanner or camera is in use by another application."



This message will appear when trying to use your scanner or digital camera if another graphics program is
already open that uses the Twain-compliant device. Close 4D QuiltDesign Creator and the other graphics
program, then reopen 4D QuiltDesign Creator and try again.

QD032 Message "Your scanner is no longer available for use. Close this
program, plug in and switch on your scanner, and run this program again."

This error appears if the connection to your scanner or digital camera has a problem. Close 4D QuiltDesign
Creator, check the connections to your scanner or digital camera, then reopen the program and try again.

QD033 Message "Failure to acquire picture due to unknown causes."

This message will appear in certain circumstances when trying to use your scanner or digital camera, for example
if the cable is disconnected during the scan or download. Close 4D QuiltDesign Creator, check the connections to
your scanner or digital camera, then reopen 4D QuiltDesign Creator and try again.

QD034 | have moved the Drawing panel, and | can't put it back in position

If the control panel is 'floating' on top of the window, double-click the title bar and the control panel will move back
to its original position.

If the control panel is docked on the wrong side of the window, click and drag the title bar to the middle of the
right-hand edge of the window until the outline snaps into position on the right. Release the mouse button and the
control panel will be dropped into its original position.

Using Reset All Modules in 4D QuiltDesign Configure will also return the control panel to its original position.

QD035 Some of the icons in the Toolbar are 'grayed out'

Certain icons (for example Send To QBOT on the Export toolbar) are only highlighted once a design is shown on
the screen.

QD036 | have changed grid color and spacing and now | wish to return to the
original settings

Use 4D QuiltDesign Configure to change the grid color. Follow the instructions in 4D QuiltDesign Configure and
select Blue Gray (RGB values 102, 102, 153) from the standard color dropdown on the Grid Color button.

Use Screen Preferences to change the grid spacing. Set the Grid Size to 0.5".

QDpo37 | wish to change the background color for the work area

Use 4D QuiltDesign Configure to alter the background color for the work area.

QD038 | can't see the control panel

Close 4D QuiltDesign Creator, and then start it again. The control panel should appear.

QD039 Message: "Design contains disconnected paths. Optimized design route
has been used."
This message may appear when using QuickTrace Picture with Custom route selected. The picture contains

areas that cannot be traced as a single line (disconnected paths). The picture will be traced using an Optimized
route.



QD040 Message: "There are no objects in this design to save."

This happens if you do a Save As on an empty element. Make sure that there are some objects to save.
You cannot save a background picture. Save your picture in image editing software before you use it.

QDo41 Message: "Embroidery too large for export format."

Certain formats are limited to the number of stitches they can save or the size of hoop used on their specific
embroidery machine, for example .sew. If you attempt to save a file in this format that is bigger than the largest
available hoop size or has more stitches than are allowed, this message would appear.

QD042 Message: "Unrecognized file extension."

This message appears if you type an incorrect extension that does not belong to any embroidery types in the File
Name box when trying to save a file.

QD043 Message: "Cannot save file."

This message appears when exporting an embroidery if, for instance, you have loaded an embroidery from a CD-
ROM and then attempt to save the embroidery back to the CD. A CD-ROM is read only, therefore you will not be
able to save the embroidery.

QD044 Message: "Embroidery has too many stitches for file format."

There is a limit on the number of stitches that may be saved to an embroidery file in Pfaff (.pcs) file format. This
message appears if the embroidery you attempt to save to this format exceeds this limit.

QDpo45 Message: "No stitch data to save."

This message appears on attempting to save when there is no embroidery on the current window.

QD046 Message: "The start and end point of a motif cannot be the same. Please
edit nodes and try again."

When exporting a motif, ensure that the line is not closed. Also ensure that the start and end points are to the left
and right of the design, and that they are along the same horizontal line.

QD047 Message: "The start and end points do not line up. Add a stitch?"

When exporting a motif, ensure that the start and end points are to the left and right of the design, along the same
horizontal line. If you click Yes, a stitch will be added to align the start and end points.

QD048 Message: "Elements cannot be placed outside the boundaries of the
Work Area."

This happens when you try to send a design to the QBOT card from a work area, and part of the design lies
outside the edge of the work area. Move these objects within the boundaries of the work area, or Select All and
reduce the size of the design, then save again.

QD049 Some of the icons in the Toolbar are 'grayed out'.



Certain icons (for example Send To QBOT on the Export toolbar) are only highlighted once a design is shown on
the screen.

Qpos50 When | imported an AutoCAD DXF (.dxf) file, it wasn’t the size | expected.

DXF files do not store units of measurement. The original size could be in inches, millimeters, or in pixels. 4D™
QuiltDesign Creator loads designs according to the measurements set in 4D™ QuiltDesign Configure. Rescale
the design after it is loaded.

QD051 An imported design was an unexpected color.

When designs are imported from quilting file formats other than *.4qgb, *.wmf, *.emf and HPGL they will appear
black in the viewer, and in the program design area. This is because color information is not saved with these
files, so the default color (black) is used.

QD052 The picture that | used as a background was not saved when | saved my
design.

QuickTrace Picture, and the Load a Picture option in the New Design Wizard, do not keep the picture that is used
for the design when saving a design.

To keep a copy of the background picture, save it separately in image editing software.

Qpo53 My stipple fill area doesn’t have a border.

Stipple fill areas are initially created without a border, as this is often the preferred style. To give a stipple fill area
a border, select Standard Line from the Lines section of the Drawing Panel.

QD054 The inside angles of my Parallel Lines are twisted.

Parallel Lines works best with a smoothly curved original digitized line. If an acute angle, or a corner of more than
90 degrees with a square node is used, the inside angle may become twisted or overlap. To use sharp angles
with parallel lines, select the line, use Convert to Lines, then edit the individual nodes on the converted line to
smooth the inside angle. It may be helpful to delete some nodes.

Qpos55 My fills looked strange after | used Combine Paths.

Combine Paths is designed to make a hole in a filled area (for example, to make two rings into a donut shape). If
one of the closed areas overlaps the edge of the other one when Combine Paths is used, areas that you might
expect to be holes may be filled.

Qpos6é Why didn’t my Motif lines or fills change size when | resized my design?

The size of the motifs in Motif Lines and Fills is set in the fill properties dialog. It cannot be changed by resizing
the object containing the fill.

To rescale the motif along with the object, use Convert to Lines on the selected object, then resize it.

QD057 The letters in my text have fills where they ought to have holes.

In complex objects such as lettering, where holes and fill areas can overlap, fills may not be in the desired places.
(Complex fonts like Wingdings may be involved). Select the affected object and use Convert to Lines. Then delete
the unwanted sections of the fill.



QD058 The block of objects | selected in the FilmStrip became an unexpected
color.

When Object Properties is used to change objects selected in the FilmStrip, the objects will become the color of
the first (top) object. To use another color, either select it in Object

Properties, or change the order of the objects in the FilmStrip.

Qpo59 When | tried to change the properties of objects selected in the FilmStrip,
only some of them changed.
If you select a mixture of lines (paths) and groups in the filmstrip, and then use Object Properties to change their

properties, the objects within the groups will be unaffected. When using Ctrl and click to select and change
objects in the FilmStrip, select all parts of a Group individually, not just the Group heading.

Qpo6o Why don’t my embroideries stitch out the same way on the quilting robot
as they do on my embroidery sewing machine?
Not all embroidery files are appropriate for stitching with quilting robots. Heavily stitched fill and satin areas in

particular are not recommended. More suitable types of designs are "Line art" designs, or those with more open
fill areas.

Qpoe1 The embroidery | want to work with appears too small on the screen.

Make sure the 4D™ QuiltDesign Creator window is maximized by clicking the Maximize icon on the title bar, then
maximize the window of the desired embroidery by clicking the Maximize icon on its title bar. Click Zoom To Fit to
expand the embroidery so it fills the window or use Zoom In together with the Overview Window to move around
the embroidery.

QD062 The selection outline partly or completely disappears when | move a
selected block.

This can happen if the block has at least one perfectly vertical or horizontal edge. The selection box around the
selected block is drawn using a method to provide maximum contrast with the background. The outline that shows
the shape of the block is drawn using the same method. When the two lines are in the same place, they cancel
each other out. If the block of stitches is a rectangle or a square, the outline may disappear completely when you
move the block. Notice that the scaling, mirror and rotate handles are always visible, so you can use these as
cues for positioning blocks where the edges are not visible.

To position blocks with missing outlines, click and drag the block approximately into position. Use the arrow keys
on the keyboard to nudge the block into its final position without needing to see the outline.

Qpoe3 "How can | tell what type of design | am loading?"

You need to be able to see the three letter extension for a file in order to know what type of design file it is.

You can make file extensions visible in Windows Explorer®. Open Windows Explorer® and select Tools, Folder
Options. In the View tab under Files and Folders, ensure the checkbox "Hide extensions for known file types" is
deselected.

apoe4 "Why do MiniPic fills appear differently in the viewer from on the screen?"

When seen in the viewer, the fill in a MiniPic may not look the same as it does on the screen. This is an effect of
the size of the design in the fill.

Check the appearance of a fill at the size at which you will be using it. Change the settings if desired.



Qpoes "Why isn’t the fill area in my design visible in the motif | created from it?"

If a design containing a fill is exported as a matif, only the outline of the design will be exported, not the fill area.
To export the fill area as part of the motif, use Convert to Lines before you use Export to MyMotifs.

apoeé "Why isn’'t my motif the same color as when | exported it?"

When a motif is exported with Export to MyMotifs only the design is saved, not the color.

When you use a motif in a line or fill it will appear in the currently selected color. If desired, change the color of the
line or fill.

QG008 Message "Cannot save file."

The program cannot save the file. Ensure that the disk where you are trying to save the design is not write-
protected, then try again.

QG009 Error "Not enough memory to perform operation."

This message will appear if system resources are low. Close other programs and try again. If this does not work,
try restarting your computer.

QG010 Message "Error 7. Dongle not found. Please attach the correct dongle to
a USB port of your computer.”

This message will appear when trying to start a module if the 4D QuiltDesign Creator software cannot detect the
dongle (data protection device). Ensure the dongle is plugged into a free USB port of your computer.

QG011 Message "Error 14. Dongle driver not found."

This message will appear if the dongle driver is not accessible, has been removed or has not been installed
correctly.

First, ensure you are logged onto your computer with full administrator rights and attempt to use the desired 4D
QuiltDesign Creator module. If the error message no longer appears, then the user name you originally tried to
use is too restricted to use the 4D QuiltDesign Creator software.

Otherwise, use the dongle driver installation utility in the \Technical\Dongle Driver folder of your 4D QuiltDesign
Creator CD. Ensure you are logged onto your computer with full administrator rights before using the dongle
driver installation utility.

QG012 General difficulties with hardware and software

To try to determine the cause of any odd difficulties with the 4D QuiltDesign Creator software, the best method is
to reboot the computer in safe mode. If the problem is then solved, you know that some clash of hardware and/or
software such as device drivers is to blame. You can then obtain more help from your computer dealer to analyze
the cause and reconfigure your computer if necessary.

To start Windows in Safe Mode

1. Close all programs.

2. Use the shortcut Alt + F4 (hold down the Alt key, then press F4 once) and the Shut Down Windows dialog
box will appear.

3. In the drop-down list, select Restart. Click OK to confirm.

4. Your computer will shut down and restart.

5. As your computer restarts, press and hold the F8 key until a menu of windows startup options appears.

6. Use the up and down arrow keys to highlight Safe mode, and then press ENTER.



When you hold down the F8 key, your computer may beep rapidly and report keyboard errors as it restarts.
Release the F8 key briefly to skip any errors and press F8 again until you have the Startup Menu on your screen.

QG013 Message "Some changes will take effect only when modules are
restarted.”

Some changes to settings on the System tab of 4D QuiltDesign Configure are only seen in the 4D QuiltDesign
Creator modules when the modules are closed and restarted. If you have made changes that do not appear
immediately, save your design(s), close the 4D QuiltDesign Creator modules, then start them again.

QG014 | have changed the screen background color and now | wish to return to
the original light blue

Use 4D QuiltDesign Configure to change the background color. Follow the instructions in 4D QuiltDesign
Configure and select the RGB values 200, 232, 247 in the Colors dialog box.

QG015 | can't see some of the floating toolbars or icons

Use Reset All Modules in 4D QuiltDesign Configure to return all toolbars in the module to their default settings.
To use Reset All Modules

. Ensure your designs are saved in any 4D QuiltDesign Creator modules that are open.

. Click 4D QuiltDesign Configure on the QuickLink toolbar.

. Click Reset All Modules.

. A message will appear, indicating that all modules will be closed and reset. Click OK.

. A message will appear, asking you to ensure that all other 4D QuiltDesign Creator modules have closed,
apart from 4D QuiltDesign Configure. Click OK.

. A message will appear, indicating that all modules have now been reset. Click OK. The toolbars in your
module will have been restored.
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If preferred, you can check individual toolbars in View, Customize. Use this to see if the missing toolbar has been
turned off, and also to reset the toolbar if icons have been added to or removed from the toolbar. If this does not
restore the toolbar, use Reset All Modules.

QG016 The toolbar icons have unexpectedly changed to a smaller size

Use Reset All Modules in 4D QuiltDesign Configure to return all toolbars in the module to their default settings
QGO006.

Alternatively, to change the icon size in this module only, select View, Customize, then go to the Options tab and
select the Large Icons option.

Qvo13 Error "Cannot open embroidery."

This message appears if the desired embroidery is not where the module expects it to be, for example if an
embroidery was loaded into the module from a floppy disk, then closed and the floppy disk removed. The
message would appear if you tried to load the embroidery from the Recent Files list on the File menu.

Qvo14 Error "Unrecognized file format."

This message appears if the file you are attempting to load is corrupt. For example, it might have the extension
.vp3, yet not be a proper Husqvarna Viking / Pfaff embroidery.

Qvo15 Error: "Embroidery is corrupt”



The embroidery is corrupt and cannot be loaded. Refer to source of this file for a solution.

Qvo16 Error "Embroidery XY coordinates incorrect”

The embroidery is corrupt and cannot be loaded. Refer to source of this file for a solution.

Qvo17 Error "Unrecognized file extension."

This message appears if you attempt to load a file with an extension that does not belong to any embroidery file
types. For example, it would appear if you tried to Drag and Drop a .doc file onto the screen.

Qvo18 Error "Design not created using licensed software."

This message may appear if you attempt to load an embroidery created in third-party software. Such
embroideries may cause unpredictable results.

4D QuiltDesign Vision

Listed versions: 2.0, 2.1

QG008 Message "Cannot save file."

The program cannot save the file. Ensure that the disk where you are trying to save the design is not write-
protected, then try again.

QG009 Error "Not enough memory to perform operation."

This message will appear if system resources are low. Close other programs and try again. If this does not work,
try restarting your computer.

QGo10 Message "Error 7. Dongle not found. Please attach the correct dongle to
a USB port of your computer.”

This message will appear when trying to start a module if the 4D QuiltDesign Creator software cannot detect the
dongle (data protection device). Ensure the dongle is plugged into a free USB port of your computer.

QG011 Message "Error 14. Dongle driver not found."

This message will appear if the dongle driver is not accessible, has been removed or has not been installed
correctly.

First, ensure you are logged onto your computer with full administrator rights and attempt to use the desired 4D
QuiltDesign Creator module. If the error message no longer appears, then the user name you originally tried to
use is too restricted to use the 4D QuiltDesign Creator software.

Otherwise, use the dongle driver installation utility in the \Technical\Dongle Driver folder of your 4D QuiltDesign
Creator CD. Ensure you are logged onto your computer with full administrator rights before using the dongle
driver installation utility.

QG012 General difficulties with hardware and software



To try to determine the cause of any odd difficulties with the 4D QuiltDesign Creator software, the best method is
to reboot the computer in safe mode. If the problem is then solved, you know that some clash of hardware and/or
software such as device drivers is to blame. You can then obtain more help from your computer dealer to analyze
the cause and reconfigure your computer if necessary.

To start Windows in Safe Mode

1. Close all programs.

2. Use the shortcut Alt + F4 (hold down the Alt key, then press F4 once) and the Shut Down Windows dialog
box will appear.

3. In the drop-down list, select Restart. Click OK to confirm.

4. Your computer will shut down and restart.

5. As your computer restarts, press and hold the F8 key until a menu of windows startup options appears.

6. Use the up and down arrow keys to highlight Safe mode, and then press ENTER.

When you hold down the F8 key, your computer may beep rapidly and report keyboard errors as it restarts.
Release the F8 key briefly to skip any errors and press F8 again until you have the Startup Menu on your screen.

QG013 Message "Some changes will take effect only when modules are
restarted.”

Some changes to settings on the System tab of 4D QuiltDesign Configure are only seen in the 4D QuiltDesign
Creator modules when the modules are closed and restarted. If you have made changes that do not appear
immediately, save your design(s), close the 4D QuiltDesign Creator modules, then start them again.

QG014 | have changed the screen background color and now | wish to return to
the original light blue

Use 4D QuiltDesign Configure to change the background color. Follow the instructions in 4D QuiltDesign
Configure and select the RGB values 200, 232, 247 in the Colors dialog box.

QGo15 | can't see some of the floating toolbars or icons

Use Reset All Modules in 4D QuiltDesign Configure to return all toolbars in the module to their default settings.
To use Reset All Modules

. Ensure your designs are saved in any 4D QuiltDesign Creator modules that are open.

. Click 4D QuiiltDesign Configure on the QuickLink toolbar.

. Click Reset All Modules.

. A message will appear, indicating that all modules will be closed and reset. Click OK.

. A message will appear, asking you to ensure that all other 4D QuiltDesign Creator modules have closed,
apart from 4D QuiltDesign Configure. Click OK.

. A message will appear, indicating that all modules have now been reset. Click OK. The toolbars in your
module will have been restored.
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If preferred, you can check individual toolbars in View, Customize. Use this to see if the missing toolbar has been
turned off, and also to reset the toolbar if icons have been added to or removed from the toolbar. If this does not
restore the toolbar, use Reset All Modules.

QGo16 The toolbar icons have unexpectedly changed to a smaller size

Use Reset All Modules in 4D QuiltDesign Configure to return all toolbars in the module to their default settings
QGO006.

Alternatively, to change the icon size in this module only, select View, Customize, then go to the Options tab and
select the Large Icons option.

Qvoo5 Message "Error. The quilt background could not be saved."



This message could appear when saving a quilt in the Quilt Background Wizard if the location for saving to is no
longer available (for example, a folder has been moved).

Qvooée Message "Error. The quilt background xxxx could not be found."

This appears if the background quilt is not found. This can happen if the name has been changed, or the location
is no longer available (for example, a folder has been moved).

Qvoo7 Message "Error. The quilt background is corrupt or incorrect."

This appears if the background quilt is not found. This can happen if the name has been changed, or the location
is no longer available (for example, a memory stick has been removed).

Qvoos Message "Error. Some designs could not be found."

This appears if one or more quilting or embroidery designs are not found. This can happen if the name has been
changed, or the location is no longer available (for example, a memory stick has been removed). A list of designs
that could not be found is given.

Qvoo9 Message "Failed loading design file xxxx. This design is ignored."

This appears if the embroidery or quilting design is corrupt in some way, for example if the file extension is .4qgb,
but it is not a true .4qgb file.

Qvo10 Message "The design will be scaled down to fit."

This message appears if the .4gb design file is too large in at least one dimension. The design will be
automatically scaled to fit.

Qvo11 Message "Error. This file cannot be opened because it is not the correct
file format."

This message appears if you try to open a file that is of the wrong type, or is corrupt.

Qvo12 Message "Error. This file cannot be opened."

This message appears if you try to open a file that is of the wrong type, or is corrupt.

Qvo13 Error "Cannot open embroidery."

This message appears if the desired embroidery is not where the module expects it to be, for example if an
embroidery was loaded into the module from a floppy disk, then closed and the floppy disk removed. The
message would appear if you tried to load the embroidery from the Recent Files list on the File menu.

Qvo14 Error "Unrecognized file format."

This message appears if the file you are attempting to load is corrupt. For example, it might have the extension
.vp3, yet not be a proper Husqvarna Viking / Pfaff embroidery.

Qvo15 Error: "Embroidery is corrupt”

The embroidery is corrupt and cannot be loaded. Refer to source of this file for a solution.



Qvo16 Error "Embroidery XY coordinates incorrect”

The embroidery is corrupt and cannot be loaded. Refer to source of this file for a solution.

Qvo17 Error "Unrecognized file extension."

This message appears if you attempt to load a file with an extension that does not belong to any embroidery file
types. For example, it would appear if you tried to Drag and Drop a .doc file onto the screen.

Qvo18 Error "Design not created using licensed software."

This message may appear if you attempt to load an embroidery created in third-party software. Such
embroideries may cause unpredictable results.

Qvo19 Error "Unrecognized file extension."

This message appears if you type an incorrect extension in the File Name box when trying to save a file.

Qvo20 Error "Cannot save file."

This message appears if, for instance, you have loaded a file from a CD-ROM and then attempt to save the file
back to the CD. A CD-ROM is read only, therefore you will not be able to save the file.

Qvo21 Some of the icons in the Toolbar are 'grayed out

Certain icons (for example the Design and Edit toolbar icons) are only highlighted once a design is shown on the
screen. Additionally, when Realistic Mode is selected, all functions that will edit designs are unavailable.

Qvo24 | created a quilt from a fabric, but now | can't load it in the Quilt
Background Wizard option to load a previously saved quilt

Fabric backgrounds are not saved as separate quilts, but as part of the quilt layout file. Save the layout
immediately after sizing the fabric background if you wish to keep a copy of the whole-cloth quilt with no designs
placed on it.

Qvo30 Message "Problem with scanner or camera software."

This message will appear when trying to use your scanner or digital camera if the device has not been installed
correctly. Close 4D QuiltDesign Vision, follow the manufacturer's instructions for the Twain-compliant device, then
reopen 4D QuiltDesign Vision and try again.

Qvo31 Message "Scanner or camera is in use by another application."

This message will appear when trying to use your scanner or digital camera if another graphics program is
already open that uses the Twain-compliant device. Close 4D QuiltDesign Vision and the other graphics program,
then reopen 4D QuiltDesign Vision and try again.

Qvo32 Message "Your scanner is no longer available for use. Close this
program, plug in and switch on your scanner, and run this program again."

This error appears if the connection to your scanner or digital camera has a problem. Close 4D QuiltDesign
Vision, check the connections to your scanner or digital camera, then reopen the program and try again.



Qvo33 Message "Failure to acquire picture due to unknown causes."

This message will appear in certain circumstances when trying to use your scanner or digital camera, for example
if the cable is disconnected during the scan or download. Close 4D QuiltDesign Vision, check the connections to
your scanner or digital camera, then reopen 4D QuiltDesign Vision and try again.

Qvo34 | wish to change the background color for the work area

Use 4D QuiltDesign Configure to alter the background color for the work area. 4D QuiltDesign Configure may
usually be used to turn the texture on or off, but this is not available for 4D QuiltDesign Vision.

Qvo35s My scanner or digital camera is not shown when | try to Select Source, or
the Select Source button is grayed out

The manufacturer of a TWAIN device must provide a Source Manager and a TWAIN Data source for your device
to work with 4D QuiltDesign Vision. These will normally be installed when you install the software and drivers
provided with the device. If you have installed a device and it is not shown in the list then it may not be TWAIN
compliant. Refer to the device documentation and manufacturer for assistance.

Qvo3e | can't drag and drop embroideries from the Open dialog box.

To drag and drop embroideries onto the Work Area, right-click Start, then Explore to start Windows® Explorer.
Then follow the instructions under Drag and Drop.

Qvo37 "l cannot load all the files in my quilt layout."

4D™ QuiltDesign Vision loads and saves quilt layouts in .4ql file format. Quilt layout files include information
about the background, design and embroidery files and their locations, but they do not include copies of the files.

If the names or locations of design or embroidery files are changed, the layout file will not be complete when it is
reloaded.



